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ABOUT THIS CLASS 

In Microsoft Project 2007 Level 1: Creating Project Tasks, the focus was on how to create a project plan 
with tasks and resources. In this class, the emphasis is on refining the project plan by adding resources to 
tasks, including assigning additional resources and exploring task type, and finalizing the project plan. 
Then once the plan is finalized, the focus shifts to managing your project using the tools provided by 
Microsoft Project to monitor project progress and also exchanging data with other applications. 

COURSE DESCRIPTION 

In this class, you will assign resources to tasks and view the effect of assigning more than one resource 
to a task. You will also learn how to view the critical path and set a baseline. Then you will manage your 
project by updating task progress, marking tasks as finishing on time or ahead or behind schedule. 
Finally, you will learn how to import or export Microsoft Project data with other programs such as Excel or 
Access and how to take a screen shot of your current view that can be used in Word, PowerPoint or in a 
web page. 

COURSE OBJECTIVES 

• Assign resources to project tasks and explore the impact of adding additional resources 
• Finalizing the project by saving a baseline, viewing critical path and looking for ways to shorten 

the duration of the project 
• Update progress on tasks including learning ways to view tasks that behind schedule 
• Work with data from other applications such as Excel or Access and export data out to other file 

formats including capturing a screen shot of the current view 
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LESSON 1 MANAGING RESOURCES IN A PROJECT PLAN 

Resource assignments are the final element in creating your project plan. You have created tasks with 
durations, created resources with costs and now you will assign resources to tasks. 

 

A. ASSIGNING RESOURCES TO TASKS 

When resources are assigned to tasks, Microsoft Project calculates how many hours it will take to 
accomplish the task, called work. To assign resources to tasks, you can use: 

• the Assign Resources button on the Standard toolbar  
• the Predecessor tab in the Task Information dialog box 
• the Predecessors column on the Entry table in the Gantt Chart view 
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ACTIVITY 1-1 ASSIGNING RESOURCES TO TASKS 

Objective:  To assign resources to tasks. 

Setup:  The file called Assign Resources is open. 

Scenario:  The project management team at Mills Marketing uses Microsoft Office Project 2007 to 
create, monitor and implement the project plans. You need to assign resources to your 
project tasks to view the work for each resource and task. 

 

WHAT YOU DO HOW YOU DO IT 

1. Launch Microsoft Office Project 
2007. 

a. On the Windows task bar, click the Start button to 
display the Start menu. 

b. In the Start menu, position the mouse pointer over All 
Programs to display them. 

c. In the All Programs submenu, choose Microsoft 
Office. 

d. Choose Microsoft Office Project 2007 to launch the 
application. 

e. If the Welcome to the 2007 Microsoft Office system 
dialog box appears, click Next. 

f. Select I don’t want to use Microsoft Update option 
to decline the usage of Microsoft Update and click 
Finish. 

2. Open the Assign Resources 
file.  

a. From the File menu, choose Open. 

b. In the Open dialog box, in the navigation pane, click 
Desktop to display the list of Folders on the Desktop. 

c. Double-click on UCB_Project2007_ManagingAProject 
folder to open it. 

d. Select Assign Resources and click Open. 

3. Assign the Project manager to 
Task 1 Start Project. 

1. Click on the Assign Resources button on the 
Standard toolbar 

2. In the Assign Resources dialog box, click on Project 

manager. 

3. Click Assign. 

4. Assign the Project manager a. In the Gantt Chart view, click and drag to select Tasks 
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and Customer Relations 
manager to Tasks 3, 4, and 5 

3, 4, and 5 Draft rules, Review rules, Finalize rules. 

b. In the Assign Resources dialog box, click on Project 
manager. 

c. Hold down <Ctrl>. 

d. Click on Customer Relations manager. 

e. Click Assign. 

f. Continue to assign resources until your project plan 
looks like the Gantt Chart view on page 5. 

5. Check the work hours 
calculated by Microsoft Project. 

a. On the View menu, choose Resource Usage to show 
the hours that resources are assigned to work on 
tasks. 

b. Choose View, Gantt Chart to return. 

c. Choose Window, Split to show the Task Entry Form 
at the bottom of the window. 

d. Click on different tasks to see the total work per 
resource on each task. 

e. Choose Window, Remove Split to close the Task 
Entry Form. 

6. Save the file. a. Choose File, Save or click the Save button on the 
Quick Access toolbar. 

7. Close the file. a. Choose File, Close. 
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Gantt Chart view 
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B. RESOURCE CALENDARS 

Resources each have their own calendar. Because each project plan may have multiple calendars, each 
resource can be assigned a base calendar. Often the project calendar is selected as the base calendar; 
however, if you have staff working in different countries, you can choose the calendar for that country as 
the base. 

An individual resource calendar can be edited to reflect that a resource is on vacation. Tasks the resource 
is assigned to will change start/finish dates as needed to reflect the time off for the resource. 

C. ASSIGNING ADDITIONAL RESOURCES TO TASKS 

When additional resources are assigned to tasks in Microsoft Project, the duration may change 
depending on the task type and Effort driven attribute of the task. Default tasks in Microsoft Project are 
Fixed Unit and Effort driven. Effort driven means that as additional resources are assigned to the task, the 
duration shortens for the task. The work is divided among more resources so it is less work per resource 
and therefore a shorter duration. 

If you need to change one resource for another because of vacation schedules, you can replace the 
resource with another without affecting duration of the task.  

Fixed Unit The default task type. Assigning additional resources to a task reduces the task’s 
duration. For example, if one resource is painting a wall, adding an additional 
resource will shorten the task’s duration. This task type can be Effort driven or not. 

Fixed Duration Duration is the fixed factor for this task, so adding an additional resource will not 
shorten duration, instead it will affect work. For example, running a Quality 
Assurance script takes the same amount of duration regardless of how many 
resources are monitoring the task. This task type can be Effort driven or not. 

Fixed Work The amount of work to be completed is fixed. If changes are made to the task’s 
duration or assigned resources, there is no change to the work value. This task type 
can only be Effort driven. 
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ACTIVITY 1-2 CHANGING RESOURCE CALENDARS AND ASSIGNING 
ADDITIONAL RESOURCES TO TASKS 

Objective:  To show a resource is on vacation and replace resources on affected tasks; assign 
additional resources to tasks to shorten the duration of the project. 

Setup:  The file called Additional Resources is open. 

Scenario:  You need to show that the Marketing manager is on vacation from May 19 to May 30, 
2008. The Marketing manager needs to be replaced for the tasks assigned during that 
time. You will also assign additional resources to your project tasks to shorten the tasks 
which will in turn shorten the project’s duration. 

 

WHAT YOU DO HOW YOU DO IT 

1. Open the Additional Resources 
file.  

a. From the File menu, choose Open. 

b. Select Additional Resources and click Open. 

2. Indicate that the Marketing 
manager will be on vacation 
from May 19 to May 30. 

a. Note the current start/finish dates for Tasks 13, 14, 
and 15 Develop logo, Design web page, Design entry 
form. These are the tasks that will be impacted by the 
vacation dates. 

b. Choose View, Resource Sheet. 

c. Double-click on Marketing manager. 

d. Click on Change Working Time. 

e. Use the scroll arrow to move to May, 2008. 

f. Click and drag to select May 19 to May 30. 

g. Click in the first Exceptions row and type Vacation. 

h. Press <Enter> to have Microsoft Project pick up the 
vacation dates you have already selected. 

i. Click OK to close the dialog. 

3. Review the Gantt Chart to see 
the effect of the vacation time. 

a. Choose View, Gantt Chart. 

b. Review Tasks 13, 14, and 15 Develop logo, Design 
web page, Design entry form. 

c. What are the new start/finish dates? 

 

 

4. Change the Marketing manager 
for another resource for the 
affected tasks. 

a. Choose Task 13 Develop logo. 

b. Click on the Assign Resources button on the 
Standard toolbar 
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c. In the Assign Resources dialog box, click on 
Marketing manager. 

d. Click Replace… 

e. Choose Project manager. 

f. Click OK. 

g. Repeat the steps to replace the Marketing manager 
with the Web Designer for Task 14 and the Customer 
Relations manager for Task 15. 

h. Click Close. 

i. Review the start/finish dates for the tasks. They should 
be back to the original dates. 

5. Shorten the duration for Task 
27 Tally Votes. 

a. What is the duration of Task 27? 
 
 

b. Double-click on Task 27 to open the Task Information 
dialog box. 

c. Click on the Resources tab. 
d. Click on the first blank row below the assigned 

resources. 
e. Click on the down arrow to open the resource list. 
f. Choose Customer Relations manger to assign an 

additional resource. 
g. Click OK. 
h. What is the duration of Task 27 now? 

 
 

i. What is the finish date of the project now? 
 
 

6. Save the file. a. Choose File, Save or click the Save button on the 
Quick Access toolbar. 

7. Close the file. a. Choose File, Close. 

 

Gantt Chart view after the Marketing manager is replaced 
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LESSON 2 FINALIZING THE PROJECT PLAN 

Now that the plan is complete, you can show the critical path in the Gantt Chart view which will show the 
tasks that must finish as planned in order for the project to finish as planned. Additionally, since the plan 
is now complete and you will be moving out of planning phase into managing the project, you should save 
a baseline version of the plan. 

A. DISPLAYING CRITICAL PATH 

The Gantt Chart view can be formatted to display the critical path tasks in red. It will make it easier for you 
to track the tasks that must finish on time. The Gantt Chart Wizard toolbar button will format critical path 
for you automatically. 

B. SHORTENING A PROJECT DURATION 

To reduce the duration of a project, you need to shorten critical path tasks. Tasks that have free time 
following them, called slack time, will not shorten the project’s duration. The Detail Gantt view will show 
you the Free Slack, slack time following the task, and the Total Slack, slack time from the task to the end 
of the project. 

ACTIVITY 2-1 DISPLAYING THE CRITICAL PATH AND SHORTENING PROJECT 
DURATION 

Objective:  To view the critical path in the project and be able to use the critical path tasks to shorten 
the project’s duration. 

Setup:  The file called Finalize is open. 

Scenario:  You are in the final stages of planning the Marketing Contest plan. You want to display 
the critical path to see which tasks need to be managed most closely. You also want to 
see if you can shorten the duration of the project at all. 
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WHAT YOU DO HOW YOU DO IT 

1. Open the Finalize file.  a. From the File menu, choose Open. 

b. Select Finalize and click Open. 

2. Show all the toolbar buttons for Standard 
and Formatting toolbars. 

a. Choose Tools, Customize, Toolbars. 

b. Click on the Options tab, if needed. 

c. Check the option to Show Standard and 
Formatting toolbars on two rows. 

 

 

3. Display the critical path. a. Click the Gantt Chart Wizard button on 
the Formatting toolbar. 

b. Click Next. 

c. Choose Critical Path in the second dialog 
box. 

d. Choose Next until Format It button 
appears. 

e. Then click Exit Wizard. 

4. Shorten the project duration by assigning 
an additional resource to Task 27 Tally 
Votes. 

a. What is the duration of Task 27? 
 
 

b. Double-click on Task 27 to open the Task 
Information dialog box. 

c. Click on the Resources tab. 
d. Click on the first blank row below the 

assigned resources. 
e. Click on the down arrow to open the 

resource list. 
f. Choose Customer Relations manger to 

assign an additional resource. 
g. Click OK. 
h. What is the duration of Task 27 now? 
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5. Save the file. a. Choose File, Save or click the Save button 
on the Quick Access toolbar 

6. Close the file. a. Choose File, Close. 
 

C. PRINTING REPORTS 

Microsoft Project contains many built-in reports plus the ability to customize reports. To view the reports: 

• Choose Report menu, Reports.  
• Double-click on Report category to open it. 
• Double-click on a report name to preview it. 

 

 



Microsoft Project 2007Level 2 Working with Resources and Managing a Project Page 14 
 

 

LESSON 3 MANAGING PROJECT TASKS 

Once your project plan is created during the planning phase of your project, you should save a baseline 
so that you can compare what actually happens during the implementation of the project plan to what you 
thought would happen. Then you will manage your project plan using Microsoft Project by marking task 
progress, changing start/finish dates as needed, viewing task progress, splitting or rescheduling work on 
tasks as needed, filtering tasks to show only selected tasks and running progress reports. 

A. CREATING A BASELINE 

Microsoft Project has fields to store Baseline Start, Baseline Finish, Baseline Cost, Baseline Duration and 
Baseline Work values. You can save up to 11 baselines in one project file. The baseline can be saved for 
the entire project or a group of selected tasks. 

To create a baseline: 

• Choose Tools, Tracking, Set Baseline 
• Save the values in Baseline, or one of the numbered Baseline fields 

B. ENTERING TASK PROGRESS 

Once your project is underway, you will need to mark task progress to reflect how work is progressing in 
the project. The Tracking toolbar provides you with buttons to view the project statistics, split tasks, show 
progress lines, mark task progress in different increments, and update task progress. 

 

 

ACTIVITY 3-1 SAVING A BASELINE AND ENTERING TASK PROGRESS 

Objective:  To save a baseline plan for your project to be able to compare what actually happened to 
what you planned and to enter progress on tasks in your project. 

Setup:  The Baseline file is open. 

Scenario:  Your project has now been underway for two weeks. You need to save a baseline plan 
and update task progress in your project plan. Some tasks have happened as planned, 
others have taken a longer or shorter duration to accomplish. 
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TABLE 3-1: TASK PROGRESS IN THE BASELINE PLAN 

Task 1 Start Project Occurred as scheduled 

Tasks 3, 4, 5 Draft rules, Review rules, Finalize rules Occurred as scheduled 

Task 7 Gather agency information Took 3 days rather than 2 days 

Task 8 Review information Took 2 days as scheduled 

Task 9 Interview agencies Took 3 days rather than 2 days 

Task 10 Select agency Took 2 days as scheduled 

Task 11 Contract with agency Took 1 day rather than 2 days 

 

WHAT YOU DO HOW YOU DO IT 

1. Open the Finalize file. a. From the File menu, choose Open.  

b. Select Finalize and click Open 

2. Update the current date to May 15, 
2008. 

a. Choose Project, Project Information. 

b. Type 5/15/08 in the Current Date text box. 

c. Click OK. 

3. Mark Task 1 as complete. a. Click on Task 1. 

b. Click the 100% button on the Tracking toolbar. 

4. Mark Tasks 3, 4, 5 as complete  a. Click and drag Tasks 3, 4, 5 to select them. 

b. Click the 100% button on the Tracking toolbar. 

5. Mark Task 7 as finishing one day 
late. 

a. Click on Task 7. 

b. Click the Update Tasks button on the Tracking 
toolbar. 

c. Type 5/5/08 in the Actual Finish text box. 

d. Click OK. 

6. Mark Task 8 as finishing as 
scheduled. 

a. Click on Task 8. 

b. Click the 100% button on the Tracking toolbar. 

7. Mark Task 9 as finishing one day 
late. 

a. Click on Task 9. 
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b. Click the Update Tasks button on the Tracking 
toolbar.   

c. Type 5/12/08 in the Actual Finish text box. 

d. Click OK. 

8. Mark Task 10 as finishing as 
scheduled. 

a. Click on Task 10. 

b. Click the 100% button on the Tracking toolbar. 

9. Mark Task 11 as finishing one day 
early. 

a. Click on Task 11. 

b. Click the Update Tasks button on the Tracking 
toolbar.   

c. Type 5/15/08 in the Actual Finish text box. 

d. Click OK. 

10. Save the file. a. Choose File, Save or click the Save button on the 
Quick Access toolbar 

11. Close the file. a. Choose File, Close. 
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Gantt Chart view 
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C. VIEWING TASK PROGRESS 

The Tracking Gantt view shows the baseline Gantt chart bars as well as your actual and planned task 
bars. It is the best view to show project progress. 

ACTIVITY 3-2 TRACKING GANTT VIEW 

Objective: To show the Tracking Gantt view. 

Setup: The Baseline file is open. 

Scenario: You have entered the progress on the first two weeks’ worth of tasks for the Baseline 
project and want to view the progress using the Tracking Gantt view. 

 

WHAT YOU DO HOW YOU DO IT 

1. Change the view to the Tracking 
Gantt and open the Tracking 
toolbar. 

a. On the View menu, choose Tracking 
Gantt to display the baseline bars as well 
as the planned bars. 

b. If needed, press <Alt> + <Home> to 
move to the beginning of the project. 

c. Right-click in a blank area of the toolbar 
area and select Tracking. 

2. Save the file. a. Choose File, Save or click the Save button 
on the Quick Access toolbar. 

 

Tracking Gantt Chart view 
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D. SPLITTING AND RESCHEDULING TASKS 

Sometimes you need to indicate a gap in the work occurring on a task. A resource is out of the office for 
some reason and the task will take longer to complete. When this occurs, you could increase the task’s 
duration, but it you are tracking costs in the project that will also increase the task’s cost. Instead you can 
split a task so show a one-day delay or reschedule work on a task if there will be a delay of multiple days.  

To split a task, use the Split Task button on the Standard toolbar: 

 

To reschedule work: 

• Choose Tools, Tracking, Update Project 
• Select Reschedule uncompleted work to start after: and type in a date to reschedule the work. 

You can choose to reschedule work for the entire project or selected tasks. 
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E. FILTERING TASKS 

Project contains both task and resource filters which allow you to reduce the tasks that you are viewing.  

Task filters 

 

Resource filters 
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F. PROJECT PROGRESS REPORTS 

Now that the project is under way, there are several ways to view project progress. The Tracking Gantt 
which you learned about above it one way. Additionally, you can show the Project Statistics, filter tasks to 
show tasks completed or print reports that show completed tasks, slipping tasks, etc. 

To show the Project Statistics dialog box: 

• Click the Project Statistics button on the Tracking toolbar 
• Or choose Project, Project Information and click on the Statistics button 

To print reports to show project progress: 

• Choose Report menu, Reports 
• Double-click on the Current Activities category of reports 
• Double-click to preview the report that you wish to view 
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LESSON 4 EXCHANGING PROJECT PLAN DATA WITH OTHER APPLICATIONS 

Microsoft Project can easily read data from other Microsoft Office Suite programs such as Excel and 
Access. Additionally, you can export data from Microsoft Project to a format that can be read by Excel or 
Access. Finally, you can take a picture of the current view, such as the Gantt Chart or Tracking Gantt, to 
either copy and paste to Word or PowerPoint or save a .gif file that can be used with web pages. 

A. IMPORTING FROM EXCEL OR ACCESS 

Although Microsoft Project 2007 is the same version as Excel or Access, it cannot read files with the extra 
“x” on the file extension such as Worksheet.xlsx or Database.mdbx which are the default file extensions in 
Office 2007. You will need to rename your files not to include the extra “x” to allow Microsoft Project to 
import them. 

To import data from Excel or Access: 

• Make sure that your security settings allow you to work with legacy file types: 
o Choose Tools, Options, Security tab. 
o Click on Prompt when loading files with legacy or non default file format. 

 

• Click OK 
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• Choose File, Open 
• Change the drop-down list that shows Microsoft Project file type by default to Microsoft Excel or 

Microsoft Access 

 

• Choose your file name 
• Click Open 
• The Import Wizard will automatically open 

 

• Step through the Import Wizard to open your Excel or Access file in Microsoft Project. 
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B. EXPORTING TO EXCEL 

In addition to opening files from Excel or Access, Microsoft Project can save to a file format that can be 
read by either of those programs. The Security settings should be set to Prompt when loading files 
with legacy file types. 

To export data to Excel or Access: 

• Choose File, Save As… 
• Change the Save As Type … drop-down list that shows Microsoft Project file type by default to 

Microsoft Excel or Microsoft Access 

 

• Choose Excel or Access 
• Choose a location and type a file name 
• Click Save 
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• The Export Wizard will automatically open 

 

• Step through the Export Wizard to save your file in an Excel or Access file format 
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C. COPYING A PICTURE FOR USE IN WORD OR POWERPOINT 

Sometimes you want to show a more visual view of your Microsoft Project file in another program. By 
using the camera button on the Standard toolbar, you can save a picture of your screen or copy it to the 
clipboard to allow it to be pasted into another program such as Word or PowerPoint. 

 

After your click the toolbar button, you will have options for how to save your view: 

• Choose how to render the image: 
o For screen copies the image to the clipboard with a resolution that is bested suited for 

viewing on a monitor 
o For printer copies the image to the clipboard with a resolution that is bested suited for 

printing 
o To GIF image file creates a .gif file that can be inserted into files such as web pages 

• Copy allows you to select either all rows showing on screen in the view or just the selected rows 
• Timescale allows you to choose what is showing on screen or a more limited date range 

 

• Click OK and Microsoft Project will export an image with the choices that you selected 

 


